Обзор Архитектуры

Введение

Данный обзор архитектуры представляет основы архитектуры цифровых сигнальных микроконтроллеров TMS320C28x (C28x) фирмы Texas Instruments. Серия C28x обеспечивает себя новый уровень многоцелевых вычислительных возможностей не существовавший в каких-либо предыдущих DSP. C28x идеально подходит для задач цифровой обработки сигналов, стандартных микроконтроллерных алгоритмов, обеспечивает эффективное выполнение кода Си и решение задач операционной системы.

Цели Изучения

Когда вы закончите эту главу, вы должны будите иметь базовые знания архитектуры C28x и принципы взаимодействия его компонент для создания высокопроизводительных однопроцессорных систем управления.

· Изучение трех главных компонент C28x
· Список основных особенностей центрального процессорного устройства C28x
· Изучение свойств и устройство памяти C28x
· Изучение встроенной в C28x периферии
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Что Представляет Собой TMS320C28x?

TMS320C28x это 32-разрядный цифровой сигнальный микроконтроллер, работающий с числами с фиксированной точкой, оптимизированный для высокопроизводительных задач управления таких как робототехника, промышленная автоматизация, устройства хранения информации, освещение, оптические сети, источники питания и другие задачи управления.
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рисунок с устройством с28х

В C28x может быть выделено три архитектурных функциональных блока:

· Центральное процессорное устройство и шины

· Память

· Периферийные устройства

Центральное Процессорное Устройство C28x
C28x содержит высоко-интегрированное высокопроизводительное процессорное ядро для требующих управления задач. C28x это слияние архитектур микроконтроллера общего назначения и цифрового сигнального процессора, сочетающий плотность кода RISC и скорости выполнения DSP архитектуры, встроенное программное обеспечение и средства разработки микроконтроллера.
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Возможности DSP выключают модифицированную Гарвардскую архитектуру и адресацию для циклических буферов. Возможности RISC это выполнение инструкций за один такт, операции типа регистр-регистр и модифицированная Гарвардская архитектура. Свойства микроконтроллера заключаются интуитивно понятном наборе команд, упаковке и распаковке битовых переменных, битовых манипуляциях.
рисунок с ЦПУ

Устройство C28x поддерживает эффективный движок языка Си, так как аппаратная часть позволяет компилятору генерировать компактный код. Множественные шины и внутренняя регистровая шина обеспечивает эффективный и гибкий подход к обработке и манипуляции данными. Архитектура также поддерживает мощные способы адресации, которые позволяют компилятору, также как и программисту на ассемблере, генерировать компактный код, который почти один в один соответствует Си коду.

C28x эффективен для решения задач цифровой обработки сигналов, также как и в задачах управления которые традиционно решаются микроконтроллерными устройствами. Эффективность освобождает от необходимости использования второго процессора в большинстве случаев.

C28x – это один из представителей семейства целочисленных DSP процессоров в TMS320-ом семействе. C28x совместим по исходному и по объектному коду с C27x. В дополнение, C28x совместим по исходному коду с 24x/240x микроконтроллерами и написанный для них код может быть перекомпилирован для устройств на базе C28x. Это позволяет переносить существующие алгоритмы на C28x.
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Умножитель, Арифметико-Логическое Устройство и Сдвиговые Регистры
рисунок

Возможность использовать умножение с накоплением формата 32х32 в C28x и 64-разрядные вычисления позволяют решать проблемы с цифровым разрешением, которые иначе потребовали бы использования более дорогого процессорного решения с плавающей точкой. Наряду с этим имеется возможность производить одновременно два умножения с накоплением формата 16х16 с использованием команды DMAC.
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рисунок

Устройство Внутренних Шин TMS320C28x
Как и во многих процессорах класса DSP, множественные шины используются для перемещения данных между памятью, периферией и ЦПУ. Архитектура шин памяти C28x содержит:

· Шина чтения программ (22-разрядная адресная шина и 32-разрядная шина данных)

· Шина чтения данных (32-разрядная адресная шина и 32-разрядная шина данных)

· Шина записи данных (32-разрядная адресная шина и 32-разрядная шина данных)
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рисунок

Использование 32-разрядной шин данных обеспечивает возможность однотактных 32-разрядных операций. Архитектура с множественными шинами известна как Гарвардская Шинная Архитектура, позволяющая C28x выбирать инструкцию, читать данные и записывать данные за один процессорный такт. Вся периферия и память подсоединяется к памяти данных.

Специальные Инструкции
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рисунок

Атомарные инструкции представляют собой маленькие простые непрерываемые инструкции. Атомарное арифметико-логическое устройство поддерживает инструкции и код для управления задачами и процессами. Эти команду обычно выполняются на несколько тактов быстрее традиционного кода.

Преимущества Конвейера
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рисунок

Для повышения производительности C28x использует защищенный 8-уровневый конвейер. Этот защищенный конвейер предотвращает возможность записи и чтения из одного адреса в порядке не предусмотренном программистом.

Этот конвейер также позволяет C28x работать на высокой скорости, не прибегая к использованию дорогой высокоскоростной памяти. Специальное устройство предсказания переходов минимизирует задержку на условных переходах. Специальным образом организованные переходы еще увеличивают производительность.

Память

Пространство памяти в C28x разделено на память программ и память данных. Существует несколько различных типов памяти, которая может быть использована как память программ, так и память данных. Она включает в себя Flash-память, ОЗУ одиночного доступа (SARAM), расширенную SARAM и загрузочное ПЗУ (Boot ROM), которое содержит код производителя процессора с загрузочной программой и стандартными математическими таблицами.

Карта Памяти

Непосредственно ЦПУ C28x не содержит памяти, но может обращаться как к памяти на кристалле, так и к внешней памяти. C28x использует 32-разрядную адресацию для данных и 22-разрядную адресацию для программ. Это позволяет достигать объема в 4 ГСлов (1 слово = 16 бит) в памяти данных и 4 МСлов в памяти программ. Области памяти всех вариантов C28x унифицировано распределены в программной памяти и памяти данных.

Эта карта памяти показывает различные области памяти доступные для программ и для данных.
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рисунок

Модуль Кодов Секретности (CSM – Code Security Module)

Модуль кодов секретности:

· Препятствует реверс-инженирингу и защищает ценную интеллектуальную собственность

· 128-разрядный ключ, определяемый разработчиком, хранится во Flash-памяти

· 128-разрядный ключ – это 2128 = 3,4 1038 возможных сочетаний паролей
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Чтобы попробовать все комбинации паролей потребуется 1,4 ∙ 1023 лет (1 пароль за 2 такта на частоте 150 МГц)

рисунок

Периферия

C28x поставляется с большим количеством встроенных периферийных устройств, оптимизированных для задач управления. Номенклатура периферии меняется в зависимости от выбранного вами конкретного C28x устройства.

· Менеджер событий

· Аналого-цифровой преобразователь

· Сторожевой таймер

· SPI
· SCI
· CAN
· McBSP
· GPIO
Быстрый Отклик на Прерывание

Для обслуживания множественных асинхронных периферийных прерываний с минимальной задержкой в микроконтроллере предусмотрено автоматическое сохранение важнейших регистров, что обеспечивает быстрый отклик на прерывание. В C28x сохранение 14 регистров контекста процессора и их восстановление выполняется с нулевыми тактами ожидания, что позволяет сократить накладные расходы по обслуживанию прерываний.
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Режим C28
C28x – это один из представителей семейства целочисленных DSP процессоров в TMS320-ом семействе. C28x совместим по исходному и по объектному коду с C27x. В дополнение, C28x совместим по исходному коду с 24x/240x микроконтроллерами и написанный для них код может быть перекомпилирован для устройств на базе C28x. Это позволяет переносить существующие алгоритмы на C28x.

Режимы C28x / C24x
Тип режима
Биты выбора режима
Опции компилятора


OBJMODE
AMODE


Режим C24x
1
1
-v28 –m20

Режим C28x
1
0
-v28 (во время семинара)

Тестовый режим
0
0
-v27

Зарезервировано
0
1


Reset
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Выводы

· Высокопроизводительный 32-разрядный DSP
· 32х32-разрядное или двойное 16х16-разрядное умножение с накоплением

· Атомарные инструкции «чтение-модификация-запись»

· 8-уровневый полностью защищенный конвейер

· Менеджер быстрого отклика на прерывание

· 128 кСлов встроенной Flash-памяти

· Модуль кодов секретности (CSM)
· Два менеджера событий

· 12-разрядный АЦП

· 56 совмещенных портов ввода/вывода общего назначения

· Сторожевой таймер

· Коммуникационная периферия

Среда Разработки Программного Обеспечения

Введение

Этот раздел объясняет как пользоваться интегрированной средой разработки программного обеспечения Code Composer Studio (CCS). Будет рассмотрен вопрос создания проектов и установки опций сборки. Будет описано назначение и использование командного файла компоновщика. В дополнении будет использована утилита конфигурирования DSP/BIOS для определения памяти и инициализации системы.

Цели Изучения

· Использование Code Composer Studio для:

· Создания проектов

· Установки опций сборки

· Создание пользовательского командного файла компоновщика который:

· Описывает имеющуюся в системе память

· Описывает правила размещения в ней секций

· Использование утилиты конфигурирования DSP/BIOS для:

· Определения памяти и инициализации системы

· Создания .cdb и .cmd файлов.

Разделы Главы

Code Composer Studio
Разработка Программного Обеспечения и Концепция COFF
Для стандартизации процесса разработки программного обеспечения Texas Instruments использует «Общий Формат Объектных Файлов» (Common Object File Format (COFF)). COFF наиболее эффективен в задачах, когда разработка программного обеспечения разделена между несколькими программистами.
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Каждый файл, содержащий программный код, может быть написан независимо и называется модулем, включая спецификацию всех ресурсов, необходимых для правильного выполнения модуля. Модули могут быть написаны в Code Composer Studio или текстовом редакторе, который может сохранять файлы в ASCII-формате. Предполагаемые расширения исходных файлов на языке ассемблера – .asm, и .c для языка Си.
Рисунок

CCS включает в себя встроенный текстовый редактор, компилятор, ассемблер, компоновщик и управление автоматической сборкой. В дополнении есть утилита подключения фалов ввода и вывода и встроенные графические дисплеи для вывода информации. Другие возможности могут быть добавлены с использованием технологии модулей расширения.

Множество модулей объединяются в завершенную программу с помощью компоновщика. Компоновщик эффективно распределяет ресурсы доступные в устройстве для каждого модуля проекта. Компоновщик пользуется командным файлом .cmd, для определения ресурсов памяти и правил расположения в них различных секций, входящих в состав модуля. Выходом процесса компоновки становится скомпонованный объектный файл .out, который может быть выполнен на DSP, и может быть получен .map файл, который показывает, куда были размещены все секции проекта.

Высокий уровень поддержки модульности и переносимости упрощает процессы проверки, отладки и поддержки проекта. Подробно процесс разработки COFF рассмотрен подробно в последующих разделах.

Концепция COFF обеспечивает модульную разработку программного обеспечения, независимую от аппаратной базы. Отдельно взятый ассемблерный файл может быть написан для выполнения определенной задачи и может быть скомпонован с несколькими другими задачами для получения более сложных систем.

Написание модульного программного кода позволяет разрабатывать код несколькими программистами параллельно, сокращая срок разработки приложений. Отладка и обновление кода становится быстрее. Новые проекты могут быть разработаны быстрее, так как в них могут использоваться модули из предыдущих проектов.

Код разрабатывается аппаратно-независимым, что позволяет программисту модуля не думать о распределении памяти, так как эта работа будет сделана на этапе компоновки проекта. При изменении любого из модулей производится новая сборка проекта и вопросы распределения памяти решаются заново, исключая вероятность появления конфликтов.
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Проекты

Code Composer работает с проектами, то есть с его помощью вы создаете проекты для каждой программы, которую хотите создать. Проект содержит в себе всю необходимую информацию для того, чтобы создать запускаемый файл. Например, он описывает такие вещи как: исходные файлы, заголовочные файлы, карту памяти конечного устройства и опции сборки программы.
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Информация проекта хранится в файле “.PJT”, который создается и обслуживается средой Code Composer. Чтобы создать новый проект необходимо выбрать пункт меню “Project:New…”.

Далее, пользуясь главным меню проекта “Project” или всплывающим по правой кнопке мыши меню, вы можете управлять открытыми проектами. Любое из этих меню позволяет вам добавлять файлы в проект (“Add Files…”). И, конечно, вы можете перетаскивать файлы в проект из «Обозревателя Windows».

Опции Сборки

Опции проекта указывают компилятору, ассемблеру и компоновщику, как собрать код в соответствии с требованиями вашей системы. Когда вы создаете новый проект, Code Composer формирует два набора опций, называемых конфигурациями: одна называется Debug – Отладочная, а вторая Release – Конечная (вы можете читать это как Оптимизированная).

Чтобы облегчить процесс настройки опций, CCS предлагает графический пользовательский интерфейс для различных настроек компилятора. На рисунке приводится пример опций для отладочной конфигурации.
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Содержимое строки компилятора полностью соответствует тому, что выбрано через пользовательский интерфейс.
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Существует много опций компоновщика, но эти четыре удовлетворяют основные потребности.

· –o <filename> определяет имя выходного (запускного) файла.

· –m <filename> указывает компоновщику создавать файл с картой проекта (map-файл).

· –c указывает компилятору, что он должен автоматически инициализировать ваши глобальные и статические переменные.

· –x указывает компоновщику перечитывать библиотеки. Без этой опции библиотеки прочитываются один раз, поэтому ссылки из одной библиотеки на другую могут не быть разрешены.

Чтобы помочь вам разобраться с множеством опций Texas Instruments предлагает два набора опций по умолчанию для новых проектов. «Конечная» конфигурация запускает оптимизатор с опцией –o3 и запрещает отладку в исходном коде исключая опцию –g (которая запрещает оптимизацию для целей отладки).

Создание Командного Файла Компоновщика

Секции
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Посмотрев на программу, написанную на языке Си, вы заметите, что она содержит одновременно и код, и разные типы данных (глобальные, локальные и т.д.).

Рисунок

У Texas Instruments и в принятом им формате COFF эти различные части программы называются секциями – Sections. Разделение кода и данных на различные секции обеспечивает гибкость, так как позволяет вам размещать кодовые секции в ПЗУ, а переменные в ОЗУ. Показанный пример показывает применение четырех типов секций:

· Глобальные переменные

· Значения инициализации глобальных переменных

· Локальные переменные (то есть стек или Stack)

· Код (выполняемые инструкции процессора)

В таблице показаны секции, создаваемые компилятором.

Имена секций компилятора

Инициализированные секции

Имя
Описание
Адрес размещения

.text
Код программы
Программа

.cinit
Инициализированные глобальные и статические переменные
Программа

.econst
Содержит данные (например, const int k = 3;)
Данные

.switch
Таблицы для оператора switch
Данные (программа для ‑mt)

.pinit
Таблицы глобальных конструкторов языка Си
Программа

Неинициализированные секции

Имя
Описание
Адрес размещения

.ebss
Глобальные и статические переменные
Данные

.stack
Пространство стека
Младшие 64К данных

.esysmem
Память для функций определения памяти far malloc
Данные

Секции вашей программы на языке Си должны размещаться в разных областях памяти вашей процессорной системы. Создавать раздельные секции для кода, констант и переменных представляет собой большое преимущество. В этом случае они могут быть размещены точно в нужную область памяти вашей процессорной системы. Обычно расположение производится следующим образом:

Программный Код (.text)
Программный код состоит из последовательности инструкций для обработки данных, инициализации системных настроек и так далее. Программный код должен быть определен во время Reset или включения питания. Поэтому в необходимо помещать программный код в энергонезависимую память такую как Flash или EPROM.

Константы (.cinit – инициализированные данные)

Инициализированными называются те области памяти данных, которые должны быть определены во время Reset или включения питания. Константы содержат начальные значения переменных или значения по умолчанию. Константы подобно программному коду определяют в энергонезависимой памяти.

Переменные (.ebss – неинициализированные данные)
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Неинициализированные области памяти содержат данные, которые могут изменяться в процессе выполнения программного кода. Эти данные, в отличие от программного кода и констант, должны находиться в ОЗУ. Эти области памяти могут модифицироваться и обновляться, как это происходит в языках высокого уровня при вычислении математических формул. Каждая переменная объявляется директивой, чтобы зарезервировать память, содержащую ее значение. В соответствии с их определением, им не присваивается какое-либо значение, а изменить их может только работающая программа.

Рисунок

Процесс компоновки кода состоит из трех шагов:

· Определение различных областей памяти (встроенная SARAM, Flash, внешняя память)

· Описание распределения секций по областям памяти

· Запуск компоновщика в процессе сборки (build) или пересборки (rebuild)

Командный Файл Компоновщика (.cmd)

Компоновщик объединяет секции из всех входных файлов, определяя память каждой секции исходя из ее длины и положения определяемого командами MEMORY и SECTIONS в командном файле компоновщика.
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Описание Карты Памяти

Область команды MEMORY описывает конфигурацию памяти процессорной системы для компоновщика.

Формат описания следующий:

Name:
origin = 0x????, length = 0x????

Например, если вы разместили 128К Flash-памяти начиная с адреса 0x3D8000, то содержимое файла будет следующим:

MEMORY

{


FLASH:
origin = 0x3D8000, length = 0x20000

}

Таким же образом определяются другие сегменты памяти. Если мы определим M0SARAM и M1SARAM, то это будет записано как:

MEMORY

{


M0SARAM:
origin = 0x000000, length = 0x0400


M1SARAM:
origin = 0x000400, length = 0x0400

}

Запомните, что микроконтроллер имеет два типа памяти: память программ и память данных. Поэтому описание каждого типа памяти должно быть раздельно. Компоновщик использует следующий синтаксис для их описания:

Страница компоновщика
Определение Texas Instruments

Page 0
Program (память программ)

Page 1
Data (память данных)

Целиком получается следующий командный файл:

MEMORY

{


PAGE 0:
/* Память программ */



FLASH:
origin = 0x3D8000, length = 0x20000


PAGE 1:
/* Память данных */



M0SARAM:
origin = 0x000000, length = 0x0400



M1SARAM:
origin = 0x000400, length = 0x0400

}

Размещение Секций

Директива SECTIONS определяет как будут распределены секции в описанной памяти. Следующий код используется для связи секций с памятью определенной в предыдущем примере:

SECTIONS

{


.text:>
FLASH
PAGE 0


.ebss:>
M0SARAM
PAGE 1


.cinit:>
FLASH
PAGE 0


.stack:>
M1SARAM
PAGE 1

}

Компоновщик будет собирать все кодовые секции из всех файлов проекта вместе. Также он поступает с остальными секциями.

Начиная с первой секции компоновщик поместит их в указанный сегмент памяти.

MEMORY

{


PAGE 0:
/* Память программ */



FLASH:
origin = 0x3D8000, length = 0x20000


PAGE 1:
/* Память данных */



M0SARAM:
origin = 0x000000, length = 0x0400



M1SARAM:
origin = 0x000400, length = 0x0400

}

SECTIONS

{


.text:>
FLASH
PAGE 0


.ebss:>
M0SARAM
PAGE 1


.cinit:>
FLASH
PAGE 0


.stack:>
M1SARAM
PAGE 1

}

Упражнение 2а

Посмотрите на следующий рисунок и создайте командный файл компоновщика.
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Заполните бланк:

MEMORY

{


PAGE __:
/* Память программ */



_____:
origin = ________, length = ________


_______:
/* Память данных */



_____:
origin = ________, length = ________



_____:
origin = ________, length = ________



_____:
origin = ________, length = ________



_____:
origin = ________, length = ________



_____:
origin = ________, length = ________

}

Выводы: Командный Файл Компоновщика

Командный файл компоновщика содержит команды для компоновщика. В файле находится:

· Описание карты памяти

· Название

· Место расположения

· Размер (длина)

· Описание секций

· Перенаправляет секции программы в объявленные области памяти

· Позволяет устанавливать индивидуальные настройки для каждого файла

· Позволяет определять разные адреса для загрузки и выполнения

Лабораторная Работа 2а: Командный Файл Компоновщика

Цель

Создать командный файл компоновщика и скомпоновать файл Си-программы (LAB2.C) в соответствии с нижеприведенным описанием.
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Описание Системы

· TMS320F2812

· Используются внутренние области памяти

Размещение Секций

· .text помещается в ОЗУ H0SARAM на странице 0 (память программ)

· .cinit помещается в ОЗУ H0SARAM на странице 0 (память программ)

· .ebss помещается в ОЗУ M1SARAM на странице 1 (память данных)

· .stack помещается в ОЗУ M0SARAM на странице 1 (память данных)

Выполнение

Создание Нового Проекта

1. Запустите Code Composer Studio и разверните его окно на весь экран. В верхней строчке располагаются разделы меню от меню Файлов (Files) до Помощи (Help). Слева и под основным меню находятся панели инструментов.

2. Проект – это набор всех тех файлов, которые требуются для создания запускного выходного файла (.out), который может быть выполнен на плате контроллера. Создадим новый проект для лабораторной работы. Для этого выберем пункт меню “Project → New”, напечатаем “Lab2” в качестве названия проекта и сохраним в директорию “C:\C28X\LABS\LAB2”. После выполнения этих действий будет создан файл с расширением “.pjt”, который определять параметры компилятора, ассемблера и компоновщика для процесса сборки. Также при создании проекта будет создана директория “Debug”, которая будет содержать непосредственно исполняемые файлы.
3. Добавим Си-файл к новому проекту через меню “Project → Add Files to Project…” и выберите файл “Lab2.c” из директории “C:\C28X\LABS\LAB2”, установив тип файла в меню фильтра “*.c”, и щелкните мышкой по кнопке “OPEN”. Файл “Lab2.c” будет добавлен в проект.
4. Добавьте файл “Lab2.cmd” таким же образом. Этот файл мы будем редактировать в процессе выполнения работы.
5. Затем добавьте библиотеку поддержки реального времени “C:\ti\c2000\cgtools\lib\rts2800_ml.lib”.
6. Если теперь Вы щелкните мышкой на значке «+» слева от “Project” в окне проекта, то появится дерево проекта, содержащее командный файл и директории с исходными файлами и библиотеками.
Опции Сборки Проекта

7. Проект конфигурируется большим числом опций для сборки (Build Options). Установки по умолчанию вполне удовлетворят нас на начальном этапе. Сейчас мы исследуем лишь некоторые из них. Выберите “Project → Build Options…”.
8. Переключитесь на закладку компоновщика (Linker). Заметьте, что Code Composer Studio будет создавать файлы “.out” и “.map”. Файл с расширением “.out” содержит исполняемый код, загружаемый в DSP. “.map”-файл содержит отчет компоновщика по распределению и использованию памяти.
9. Установите размер стека (Stack Size) равным 0x200. Нажатием на кнопку “OK” закройте окно опций сборки (Build Options).
Редактирование Командного Файла Компоновщика – lab2a.cmd
10. Чтобы редактировать файл “Lab2a.cmd”, выполните двойной щелчок мышью на имени файла на дереве проекта.

11. Отредактируйте содержимое файла, чтобы память была описана так, как показано в разделе «размещение секций».

12. ???

13. Определите расположение секций в памяти с помощью области SECTIONS{}. Сохраните Вашу работу.

Сборка и Загрузка Проекта

14. Четыре кнопки на горизонтальной панели инструментов отвечают за процесс компиляции:

Кнопка
Название
Описание

1
Compile File
Компилировать или ассемблировать текущий открытый файл

2
Incremental Build
Компилировать и ассемблировать изменившиеся файлы, а затем компоновать

3
Rebuild All
Компилировать и ассемблировать, а затем компоновать

4
Stop Build
Остановить любой из вышеперечисленных процессов

15. Code Composer Studio может осуществлять автоматическую загрузку программы после сборки в память микроконтроллера. Найдите в меню пункт “Option → Customize…”, а затем выберете закладку “Program Load Options” и установите галочку напротив “Load Program After Build”, затем нажмите “OK”.
16. Нажмите кнопку “Build All” и посмотрите, как компилятор и компоновщик выполняются в окне сборки. Проверьте наличие ошибок (мы специально внесли ошибку в исходный текст). Когда Вы получите сообщение об ошибке, прокрутите окно сборки, пока не увидите, выделенное красным сообщение. Двойным щелчком мыши по сообщению можно перейти к исходному тексту. Курсор будет установлен на строку, в которой компилятор обнаружил ошибку.

17. Исправьте ошибку, добавив знак точки с запятой после “c = a + b”. В будущем учтите, что одна ошибка может вызывать сразу несколько сообщений об ошибках во время сборки, но не в данном случае.

18. Выполните новую сборку (теперь ошибки должны отсутствовать). Выходной файл должен быть загружен автоматически. Счетчик команд указывает на “_c_int00 в окне дизассемблера.

19. В меню “Debug” выберите пункт “Go Main” и вы перейдете к main() выполнив процедуру инициализации библиотеки rts2800_ml.lib.

Окна Отладочной Среды

Обычно во время отладки требуется наблюдать глобальные и локальные переменные. Существует несколько способов для этого в среде Code Composer Studio. Мы рассмотрим два способа: окна памяти (memory window) и окна наблюдения (watch window).

20. Откройте окно памяти (memory window), чтобы посмотреть глобальную переменную “c”. Для этого выберете пункт меню “View → Memory”. Впечатайте “&c” в строку адреса. Символ “&” означает, что используется адрес переменной, иначе будет использоваться ее значение. Также помните, что Code Composer Studio чувствителен к регистру. Вы можете менять формат отображения, например, на “Hex – TI style”, что обеспечивает более удобное отображение информации. Нажав “OK” вы увидите, что окно памяти открылось и начальный адрес указывает на переменную “c”. Вы можете изменять содержимое памяти по любому адресу, используя двойной щелчок мышью на значении выбранной ячейки. Это полезно во время отладки.
21. Откроем окно наблюдения (watch window), чтобы посмотреть значения локальных переменных “a” и “b”. Выберете пункт меню “View → Watch Window”. Щелкните на закладке “Watch Locals” и Вы увидите, что переменные “a” и “b” уже наблюдаемы. Watch Window будет всегда содержать локальные переменные для исполняемой функции. Следует отметить, что все локальные переменные располагаются в стеке. Вы можете наблюдать локальные переменные в Memory Window, установив адрес на “SP” (указатель стека) после того как микроконтроллер начал исполнение функции.
22. Мы можем добавлять в Watch Window глобальные переменные. Для этого выберите закладку “Watch1”. В пустом контейнере в колонке “Name” напечатайте “c”. Заметьте, что Вы не должны использовать знак “&” при этом, то есть окно “Watch Window” знает, что Вы имеете в виду переменную. Проверьте, что Watch Window показывает то же значение, что и Memory Window. Изменение значения переменной в одном из окон приведет к изменению его в другом и подсветке красным цветом.
Выполнение Программы по Шагам

23. Выполнение функции main() по шагам осуществляется с помощью клавиши “F8” или кнопки “Single Step” на вертикальной панели инструментов. Проверьте, правильно ли работает программа. Какое значение приобретает “c” по завершению программы?

Конец упражнения
Инструмент Конфигурирования DSP/BIOS
Инструмент конфигурирования DSP/BIOS (DSP/BIOS Configuration Tool) создает и изменяет системный файл, называемый Конфигурационной Базой Данных (Configuration Database .CDB). Если упоминаются .CDB-файлы, то речь идет об инструменте конфигурирования.
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Рисунок

Графический пользовательский интерфейс (Graphical User Interface – GUI) упрощает разработку системы:

· Автоматически подключает необходимые библиотеки

· Автоматически обрабатывает вектора прерываний и перезапуск (reset)

· Определяет конфигурацию системной памяти (создает CMD-файл)

· Когда CDB-файл сохранен, инструмент конфигурирования создает 5 дополнительных файлов

Имя_файла.cdb
Конфигурационная база данных

Имя_файлаcfg_c.c
Си-код, создаваемый инструментом конфигурирования

Имя_файлаcfg.s28
ASM-код, создаваемый инструментом конфигурирования

Имя_файлаcfg.cmd
Командный файл компоновщика

Имя_файлаcfg.h
Заголовочный файл для *cfg_c.c

Имя_файлаcfg.h28
Заголовочный файл для *cfg_c.s28

Когда Вы добавляете CDB-файл в Ваш проект, CCS автоматически добавляет сгенерированные файлы в проект в директорию “Generated Files”. Однако сгенерированный командный файл необходимо добавить самостоятельно.

Создание Областей Памяти (Используя MEM)

Сначала Вы должны открыть CDB-файл двойным щелчком мыши в дереве проекта. Затем раскройте раздел “System”, нажмите правой клавишей мыши на разделе “MEM” и выделите “Insert MEM”. Присвойте области уникальное имя, начальный адрес, длину и тип. После создания в область памяти можно перенаправить секции.
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Рисунок

Распределение Секций – Менеджер Свойств MEM
Инструмент конфигурирования предоставляет удобный способ распределения секций по областям памяти. Каждая, из предопределенных компилятором секций, имеет свое ниспадающее меню, в котором Вы можете выбрать, определенную Вами область памяти.
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Запуская Компоновщик

Создаем командный файл компоновщика (с помощью .CDB)
Когда Вы закончили создание областей памяти и секций в эти области (то есть когда Вы сохранили .CDB-файл), инструмент конфигурирования CCS создает пять файлов. Один из них является командный файл компоновщика среды DSP/BIOS.
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Этот файл, как и обычные командные файлы, состоит из двух частей MEMORY и SECTIONS (правда, его содержимое несколько отличается от показанного на картинке).

Запуская компоновщик

Главная задача компоновщика – собрать вместе набор различных объектных файлов. Он собирает одноименные секции из различных объектных файлов и размещает их в указанных областях памяти. Во время этого процесса он вычисляет абсолютные адреса для всех символических имен упоминающихся в Вашем коде.
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Компоновщик производит два файла – выполняемый .out-файл и файл отчета (.map), содержащий информацию о результатах компоновки. Компоновщик запускается автоматически, когда выполняете сборку (Build) или пересборку (Rebuild).

Лабораторная Работа 2б: Инструмент Конфигурирования DSP/BIOS
Цель

Используя CCS и Инструмент конфигурирования DSP/BIOS необходимо создать файл конфигурационной базы данных (*.CDB). Полученный файл “Labcfg.cmd” будет использован с “Lab2.c”, чтобы проверить инвариантность решений. Описание памяти и распределение секций пользовательского командного файла будут удалены, однако этот командный файл еще пригодится в будущем при выполнении других лабораторных работ.
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Описание Системы

· TMS320F2812

· Используются внутренние области памяти

Размещение Секций

· .text помещается в ОЗУ H0SARAM на странице 0 (память программ)

· .cinit помещается в ОЗУ H0SARAM на странице 0 (память программ)

· .ebss помещается в ОЗУ M1SARAM на странице 1 (память данных)

· .stack помещается в ОЗУ M0SARAM на странице 1 (память данных)

Выполнение

Создать Новый Проект

1. Если CCS не запущен, запустите его и загрузите последний редактируемый проект “Project → Resent Project Files”.
Удаление “rts2800_ml.lib” и “Lab2a.cmd” из Проекта

2. Выделите файл “rts2800_ml.lib” в директории проекта и удалите его, нажав клавишу “del” или воспользовавшись пунктом “Remove from Project”. Инструментарий DSP/BIOS содержит свои собственные библиотеки.

3. Удалите из проекта файл “Lab2a.cmd” аналогичным образом. Мы будем использовать инструмент конфигурирования DSP/BIOS для создания командного файла компоновщика.

Используем Инструмент Конфигурирования DSP/BIOS
4. Создаваемый конфигурационный (*.cdb) файл контролирует широкий спектр возможных настроек CCS. В этом упражнении CDB-файл будет использоваться для автоматического управления распределением памяти. Создайте новый CDB-файл с помощью меню “File → New → DSP/BIOS Configuration…”. Появится диалоговое окно. В диалоговом окне будут показаны шаблоны CDB-файлов, имеющие специфические настройки для каждого возможного типа микроконтроллера. Выберете “c28xx.cdb” и нажмите “OK”.

5. Сохраните конфигурационный файл в директории “C:\C28X\LABS\LAB2\”, выбрав “File → Save As…” и назовите его “Lab.cdb”. Закройте окно конфигурации.

6. Добавьте конфигурационный файл “Lab.cdb” в проект: “Project → Add Files to Project…”. Убедитесь, что Вы открываете файл в нужной директории и правильно выставили маску файлов (*.cdb).

7. Добавьте сгенерированный командный файл компоновщика “Labcfg.cmd” в проект таким же способом.

Создаем Новые Области Памяти Используя CDB-файл

8. Откройте файл “Lab.cdb” раскрыв директорию “DSP/BIOS Config” и выполнив двойной щелчок на имени файла. Раскройте раздел “System” и в нем “MEM”.

9. По умолчанию в менеджере памяти (Memory Section Manager) области L0SARAM и L1SARAM описаны как один блок L0SARAM. Таким же образом описаны блоки M0SARAM и M1SARAM. Мы хотим разделить эти области, чтобы привести их в соответствии с рисунком. Нажмите правой клавишей на “MEM” и выберите “Insert MEM”. Переименуйте вновь созданные области в “L1SARAM” и “M1SARAM”.

10. Измените длину и начальный адрес четырех блоков “M0SARAM”, “M1SARAM”, “L0SARAM” и “L1SARAM” в соответствии с рисунком. Чтобы модифицировать эти свойства, необходимо нажать правой кнопкой мыши на соответствующем блоке и выбрать “Properties”. Убедитесь, что опция “Create a heap in memory” включена ТОЛЬКО для блока памяти L0SARAM. Выключите ее для остальных трех секций.

11. Войдите в пункт “Properties” контекстного меню раздела “MEM”. Выберете закладку секций компилятора “Compiler Sections” и разместите секции “.text”, “.cinit” и “.ebss” в области памяти в соответствии с рисунком. На закладке данных BIOS “BIOS Data” аналогично сконфигурируйте секцию “.stack”. Нажмите “OK”и сохраните файл настроек.

Установка Размера Стека в CDB-файле

12. Если Вы помните, размер стека в предыдущей лабораторной работе размер стека был определен в опциях проекта CCS. Когда Вы используете инструмент конфигурирования DSP/BIOS, размер стека определяется в CDB-файле. Первым делом нам надо удалить размер стека из опций CCS.

13. Перейдите в меню “Project → Build Options…” и на закладку “Linker”. Удалите содержимое опции “Stack Size”. Нажмите “OK”.

14. Вызовите контекстное меню “MEM” и выберите в пункт “Properties”, а затем закладку “General”. По умолчанию размер стека установлен в 0x200, поэтому изменять ничего не требуется.

Сборка и Загрузка Проекта

15. Нажмите кнопку “Build” и проект будет откомпилирован и скомпонован. Выходной файл загрузится автоматически. Счетчик команд будет указывать на “_c_int_00” в окне дизассемблера.

16. Выберите пункт меню “Debug → Go Main”. Программа будет запущена, исполнит процедуру инициализации DSP/BIOS и остановится на функции “main()” файла “Lab2.c”.

Запуск Программы

Проверим правильность выполнения программы, выполняя ее по шагам и наблюдая результат в “Watch Window”.

Конец упражнения

Заголовочные Файлы Периферийных Регистров

Введение

Назначение заголовочных Си-файлов – упростить программирование множественной периферии микроконтроллеров TMS320F28xx. Обычно для программирования периферийного устройства программист должен писать нужные значения в различные поля управляющих регистров. В простейшем варианте это сводится к записи шестнадцатеричных данных в конкретные адреса памяти или маскирование конкретных бит. Для упрощения этой утомительной процедуры были созданы заголовочные файлы.

Заголовочные Си-файлы F281x являются частью библиотеки и состоят из Си-функций, макросов, периферийных структур и определений переменных.

Регистры и битовые поля представлены в виде структур данных. Для инициализации и изменения регистров (структур) используются Си-функции или макросы.

В данном разделе Вы узнаете, как использовать заголовочные файлы и Си-программы для упрощения программирования периферии.

Цели Изучения

· Обучение использованию заголовочных файлов

· Обучение программированию периферийных регистров

· Изучение вопроса описания периферии в командном файле компоновщика

Разделы Главы

Традиционный и Структурный Подход к Си-программированию

Традиционный подход
#define ADCTRL1
(volatile unsigned int *)0x00007100

#define ADCTRL2
(volatile unsigned int *)0x00007101





...

void main(void)

{


*ADCTRL1 = 0x1234;
// Запись регистра целиком


*ADCTRL2 |= 0x4000;
// Сброс первого секвенсера

}

Преимущества:

· Просто, быстро и легко печатать

· Имя переменной точно соответствует имени регистра (легко запомнить)

Недостатки:

· Требует создавать индивидуальные маски для манипуляции индивидуальными разрядами

· Не может отображать значения битовых полей в Watch Window (требуется готовить поля для вывода с помощью логических функций)

· Во многих случаях генерирует менее эффективный код 

Структурный подход

void main(void)

{


AdcRegs.ADCTRL1.all = 0x1234;
// Запись регистра целиком


AdcRegs.ADCTRL2.bit.RST_SEQ1 = 1;







// Сброс первого секвенсера

} 

Преимущества:

· Просто работать с индивидуальными разрядами

· Возможности Watch Window используются на 100%

· Создает наиболее эффективный код (на C28x)

Недостатки:

· Трудно запомнить имена структур (Code Maestro помогает)

· Больше приходится печатать (Code Maestro помогает)

Рисунок «Окно Watch Window CCS с использованием #define»

Рисунок «Окно Watch Window CCS с использованием Структур»

Эффективен ли структурный подход?

Структурный подход включает в компиляторе эффективное использование страничной адресации и атомарных операций C28x.

Исходный Си-код
Компилированный ассемблерный код

// Остановить CPU Timer0

CpuTimer0Regs.TCR.bit.TSS = 1;

// Загрузить новое 32-разрядное

// значение периода

CpuTimer0Regs.PRD.all = 0x00010000;

// Запустить CPU Timer0

CpuTimer0Regs.TCR.bit.TSS = 0;
MOVW
DP, #0030

OR
@4, #0x0010

MOVL
XAR4, #0x010000

MOVL
@2, XAR4

AND
@4, #0xffef

· Код легко читается без комментариев

· Битовые маски встроены в структуры
5 слов, 5 тактов

Данный пример не может быть запрограммирован более эффективно на ассемблере.

Сравнение с использовании #define
Традиционны подход с #define использует менее эффективные указатели для произвольного доступа к памяти, что не позволяет использовать преимущества атомарных инструкций C28x.

Исходный Си-код
Компилированный ассемблерный код

// Остановить CPU Timer0

*TIMER0TCR |= 0x0010;

// Загрузить новое 32-разрядное

// значение периода

*TIMER0TPR32 = 0x00010000;

// Запустить CPU Timer0

*TIMER0TCR &= 0xFFEF;


MOV
AL, *(0:0x0c04)

ORB
AL, #0x10

MOV
*(0:0x0c04), AL

MOVL
XAR4, #3072

MOVL
XAR5, #65536

MOVL
*+XAR4[0], XAR5

MOV
AL, *(0:0x0c04)

AND
AL, #0xffef

MOV
*(0:0x0c04), AL

· Код плохо читается без комментариев

· Битовые маски должен определять программист
9 слов, 9 тактов

Правила именований

Заголовочные файлы используют общие правила именований. Они совместимы с инструментом конфигурирования и создаваемыми им файлами.

Правила Именования Структур

Заголовочные файлы DSP281x определяют:

· Все периферийные структуры

· Названия всех регистров

· Названия всех битовых полей

· Адреса всех регистров

PeripheralName.RegisterName.all

// Доступ к 16 или







// 32-разрядному регистру







// целиком

PeripheralName.RegisterName.half.LSW
// Доступ к младшим 16







// разрядам 32-разрядного







// регистра

PeripheralName.RegisterName.half.MSW
// Доступ к старшим 16







// разрядам 32-разрядного







// регистра

PeripheralName.RegisterName.bit.FieldName
// Доступ к








// определнному








// битовому полю

Замечания:

· “PeripheralName” определены Texas Instruments и могут быть найдены в заголовочных файлах DSP281x, представляют собой комбинацию заглавных и строчных букв (например, CpuTimer0Regs)

· “RegisterName” такие же как в описании на процессор, всегда заглавные буквы (например, TCR, TIM, TPR,…)

· “FieldName” такие же как в описании на процессор, всегда заглавные буквы (например, POL, TOG, TSS,…)
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Пример Описания Периферийной Структуры в .h-файле

В файле “main.c”:

#include “DSP281x_Device.h”

void InitAdc(void)

{


/* Перезапуск модуля АЦП */


AdcRegs.ADCTRL1.bit.RESET = 1;


/* Конфигурирование регистров АЦП */


AdcRegs.ADCTRL1.all = 0x0710;

};

В файле “Adc.h”:

/* Определение бит регистра АЦП */

struct ADCTRL1_BITS {


// Описание бит


Uint16 rsvd1:4;

// 3:0 Зарезервированы


Uint16 SEQ_CASC:1;
// 4 Каскадный режим секвенсера


Uint16 rsvd2:1;

// 5 Зарезервировано


Uint16 CONT_RUN:1;
// 6 Циклическое преобразование


Uint16 CPS:1;

// 7 Делитель частоты ядра АЦП


Uint16 ACQ_PS:4;

// 11:8 Время выборки


Uint16 SUSMOD:2;

// 13:12 Режим работы с






// эмулятором


Uint16 RESET:1;

// 14 Перезапуск АЦП


Uint16 rsvd3:1;

// 15 Зарезервировано

};

/* Разрешение доступа к битовым полям или регистру целиком */

union ADCTRL1_REG {


Uint16
all;


Struct
ADCTRL1_BITS
bit;

};

// Внешние ссылки и определение функций

extern volatile struct ADC_REGS AdcRegs;

Размещение Структур в Памяти

Структуры детально описывают набор регистров. Каждая структура связана с адресом в памяти. Это достигается в два этапа: объявление новой секции с помощью DATA_SECTION pragma и направления секции в определенную в командном файле компоновщика область памяти.

Пример Размещения Структуры в Памяти

· DATA_SECTION pragma используется для определения уникального имени секции для периферийной структуры

DSP281x_GlobalVariableDefs.C

#pragma DATA_SECTION(AdcRegs, “AdcRegsFile”);

· Командный файл компоновщика направляет секцию в область физической памяти

DSP281x_Headers_BIOS.CMD

MEMORY

{

PAGE 1:


...


ADC:
origin=0x007100, length=0x000020


...

}

SECTIONS

{


...


AdcRegsFile
:>
ADC
PAGE=1


...

}

Командный Файл Компоновщика

Когда используются заголовочные файлы пользователь добавляет в раздел MEMORY области соответствующие CODE_SECTION и DATA_SECTION pragmas, которые встречаются в .h- и .c-файлах.

Пользователь может изменять свой собственный командный файл или использовать готовые файлы “EzDSP_RAM_lnk.cmd” или “F2812.cmd”. Эти файлы содержат описание периферийных областей памяти для каждого устройства в отдельности.

Заголовочные Си-файлы F281x
Заголовочные файлы состоят из .h-файлов, исходных Си-файлов, командных файлов компоновщика, а также образцов программ, документации и дополнений к CCS.

Набор Заголовочных Си-файлов F281x
· Упрощает программирование периферии

· Включает определение регистров и их адресов

· Набор заголовочных файлов состоит из:

· \DSP281x_headers\include
→ .h-файлы
· \DSP281x_common\src
→ исходные Си-файлы

· \DSP281x_headers\cmd
→ командные файлы компоновщика

· \DSP281x_headers\gel

→ .gel-файлы CCS

· \DSP281x_examples

→ примеры программ

· \doc



→ документация

· Texas Instruments сделала всю работу за Вас

Периферия программируется, когда Вы прописываете значения в регистры. Иногда поля могут быть записаны как биты, байты или целые слова. Объединения (unions) используются для того, чтобы к содержимому регистра можно было обращаться разными способами. Заголовочный файл описывает все регистры принадлежащие конкретному периферийному устройству.

Файл DSP281x_Periferal.gel предоставляет возможность пользователю загружать структуры периферийных регистров в Watch Window. CCS может загружать GEL-файлы автоматически. Для того, чтобы происходила автоматическая загрузка, в стандартном GEL-файле “F2812.gel” (который является частью CCS) добавьте:

GEL_LoadGel(“base_path/gel/DSP281x_Peripheral.gel”)

.h-файлы Определений

Файл “DSP281x_Device.h” является главным подключаемым заголовочным файлом. Если Вы включите ссылку на этот файл в Вашей Си-программе, то все .h-файлы, описывающие периферийные устройства будут добавлены автоматически. Конечно, любой из этих файлов может быть подключен индивидуально или Вы можете закомментировать те файлы, которые Вам не потребуются.

· Файлы находятся в директории “\DSP281x_headers\include”

· Файлы описывают структуры и битовые поля периферийных и системных регистров

· Файл “DSP281x_Device.h” является главным и подключает все .h-файлы

#include “DSP281x_Device.h”

· DSP281x_Device.h

· DSP281x_SysCtrl.h

· DSP281x_Adc.h

· DSP281x_ECan.h

· DSP281x_Gpio.h

· DSP281x_Sci.h

· DSP281x_Xintf.h

· DSP281x_PieVect.h

· DSP281x_DevEmu.h

· DSP281x_PieCtrl.h

· DSP281x_CpuTimers.h

· DSP281x_Ev.h

· DSP281x_Mcbsp.h

· DSP281x_Spi.h

· DSP281x_XIntrupt.h

· DSP281x_DefaultIsr.h

Файл Определения Глобальных Переменных

Файл “DSP281x_GlobalVariableDefs.c” подключается к проекту и определяет глобальными все области памяти периферийных устройств и их регистры. Области связываются с секциями, а компоновщик размещает их в памяти в соответствии с описанием в его командном файле.

Специальные Процедуры Периферийных Устройств

Специальные процедуры периферийных устройств служат для инициализации периферии. Си-файлы соответствующих устройств добавляются к проекту.

· DSP281x_SysCtrl.c

· DSP281x_PieCtrl.c

· DSP281x_Adc.c

· DSP281x_CpuTimers.c

· DSP281x_ECan.c

· DSP281x_Ev.c

· DSP281x_PieVect.c

· DSP281x_Gpio.c

· DSP281x_Mcbsp.c

· DSP281x_Sci.c

· DSP281x_Spi.c

· DSP281x_Xintf.c

· DSP281x_XIntrupt.c

· DSP281x_DefaultIsr.c

Пакет содержит и другие файлы:

· Командные файлы компоновщика “Linker.cmd”

· “DSP281x_Headers_BIOS.cmd” и “DSP281x_Headers_nonBIOS.cmd”

· Содержат описание распределения памяти для периферийных структур, определенных в заголовочных файлах пакета

· DSP281x_CodeStartBranch.asm, который используется для перенаправления хода выполнения программы во время загрузки


.ref
_c_int00


.sect
“codestart”


LB
_c_int00

Пример Использования

Выводы: Заголовочные Файлы Периферийных Регистров

· Легче разрабатывать код

· Легко пользоваться

· Производит наиболее оптимальный код

· Увеличивает эффективность CCS Watch Window
· Texas Instruments уже сделали всю работу

Сброс и Прерывания

Введение

Данная глава описывает процесс прерываний и объясняет принципы работы блока расширения периферийных прерываний.

Цели Изучения

· Процесс сброса C28x и состояние после сброса

· Последовательность событий в процессе возникновения прерывания

· Структура прерываний C28x
Разделы Главы

Линии Прерываний Ядра Микроконтроллера

Ядро C28x имеет:

· 2 немаскируемых прерывания (/RS и “переключаемое” NMI)

· 14 маскируемых прерываний

Рисунок

Сброс

Существует два источника сброса:

· От ножки /RS микроконтроллера

· От Сторожевого таймера (Watchdog Timer)

Рисунок

Заметьте, что сигнал сброса с ядра выдается также и на ножку микроконтроллера.

Состояние Регистров при Сбросе

Сброс определяет следующее состояние регистров микроконтроллера:

PC
0x3F FFC0
В счетчик команд загружается вектор сброса

ACC
0x0000 0000
Аккумулятор очищается

XAR0 – XAR7
0x0000 0000
Вспомогательные регистры очищаются

DP
0x0000
Указатель страниц данных устанавливается на нулевую страницу

P
0x0000 0000
Регистр результата очищается

XT
0x0000 0000
Регистр временного хранения очищается

SP
0x0400
Указатель стека устанавливается на адрес 0x0400

RPC
0x0000 0000
RPC очищается ??????

IFR
0x0000
Нет ждущих прерываний

IER
0x0000
Маскируемые прерывания запрещены

DBGIER
0x0000
Отладочные прерывания запрещены

Состояние Флагов и Управляющих Бит После Сброса

Регистр состояния 0 (ST0):
SXM = 0
Режим расширения знакового разряда выключен

OVM = 0
Режим ограничения переполнения выключен

TC = 0
Флаг тестирования и управления

C = 0
Бит переноса

Z = 0
Флаг нуля

N = 0
Флаг отрицательного числа

V = 0
Бит переполнения

PM = 000
Устанавливается на единичный сдвиг влево

OVC = 00 0000
Счетчик переполнений

Регистр состояния 1 (ST1):
INTM = 1
Все маскируемые прерывания запрещены

DBGM = 1
Все события эмуляции выключены

PAGE0 = 0
Включен режим адресации через стек / Прямая адресация выключена

VMAP = 1
Вектора прерываний находятся по адресам в памяти программ с 0x3F FFC0 по 0x3F FFFF

SPA = 0
Указатель стека выравнивается по четным адресам

LOOP = 0
Статусный бит команды LOOP

EALLOW = 0
Бит разрешения работы с эмулятором

IDLESTAT = 0
Статусный бит команды IDLE

AMODE = 0
Режим адресации C27x/C28x

OBJMODE = 0
Режим совместимости с C27x

M0M1MAP = 1
Бит конфигурирования памяти

XF = 0
Статусный бит ножки XF

ARP = 0
ARP указывает на AR0

Сброс и Загрузка

Рисунок

Примечания:
· Ножка XMPNMC в F281x привязана к нулю внутри микроконтроллера

· Ножка XMPNMC настроена на ввод

· Ножка XMPNMC опрашивается только в момент сброса

· Статусный бит MP/MC является частью регистра XINTFCNF2

Опции Загрузки

Ножки портов дискретного ввода/вывода


F4
F12
F3
F2


1
x
x
X
Переход на FLASH по адресу 0x3F 7FF6


*

0
0
1
0
Переход на H0SARAM по адресу 0x3D 8000

*

0
0
0
1
Переход на однократно программируемое ПЗУ по адресу 0x3D 7800





*

0
1
x
X
Загрузка из внешней FLASH во встроенную память по SPI (последовательному периферийному интерфейсу)

0
0
1
1
Загрузка программы во встроенную память через SCI-A (последовательный коммуникационный интерфейс)

0
0
0
0
Загрузка программы во встроенную память через параллельный интерфейс порта B

* Загрузочное ПО конфигурирует микроконтроллер в режим C28x перед переходом

Блок-схема Программы Сброса

Рисунок

Источники Прерываний

Рисунок

Обработка Прерываний

Рисунок

Если возникает сигнал прерывания по одной из линий, то соответствующий бит защелкивается в регистре флагов прерываний. Если собственный и глобальный ключи включены, то запрос на прерывание достигает ядра.

Регистр Флагов Прерываний (IFR)

15
14
13
12
11
10
9
8

RTOSINT
DLOGINT
INT14
INT13
INT12
INT11
INT10
INT9

7
6
5
4
3
2
1
0

INT8
INT7
INT6
INT5
INT4
INT3
INT2
INT1

Прерывание является ждущим, если соответствующий бит равен «единице». Запрос на прерывание отсутствует, если соответствующий бит равен «нулю».

/* Установка значений регистра IFR программно */

extern cregister volatile unsigned int IFR;


IFR |= 0x0008;
// Устанавливает флаг INT4 в IFR


IFR &= 0xFFF7;
// Очищает флаг INT4 в IFR

· Компилятор генерирует непрерываемые атомарные инструкции для установки и очистки IFR
· Если прерывание происходит во время записи в IFR, то приоритет предоставляется прерыванию

· Соответствующий бит в IFR очищается, если прерывание подтверждено процессором

· Регистр оказывается очищен после сброса

Регистр Разрешения Прерываний (IER)

15
14
13
12
11
10
9
8

RTOSINT
DLOGINT
INT14
INT13
INT12
INT11
INT10
INT9

7
6
5
4
3
2
1
0

INT8
INT7
INT6
INT5
INT4
INT3
INT2
INT1

Прерывание разрешено, если соответствующий бит равен «единице». Прерывание запрещено, если соответствующий бит равен «нулю».

/* Установка значений регистра IER программно */

extern cregister volatile unsigned int IFR;


IER |= 0x0008;
// Разрешает прерывание INT4 в IER


IER &= 0xFFF7;
// Запрещает прерывание INT4 в IER

· Компилятор генерирует непрерываемые атомарные инструкции для установки и очистки IFR
· Регистр оказывается очищен после сброса

Бит Глобальной Маски Прерываний



Bit 0

ST1

INTM

· INTM используется для глобального разрешения/запрещения прерываний.

· Прерывания разрешены:
INTM = 0
· Прерываний запрещены:
INTM = 1 (значение после сброса)

· INTM может быть изменен только через ассемблерный код


asm(“
CLRC
INTM”);
// Разрешает прерывания


asm(“
SETC
INMT”);
// Запрещает прерывания

Расширение Периферийных Прерываний (PIE)

Рисунок

Регистры PIE

PIEIFRx (x = 1 – 12)

15 – 8
7
6
5
4
3
2
1
0

зарезервировано
INTx.8
INTx.7
INTx.6
INTx.5
INTx.4
INTx.3
INTx.2
INTx.1

PIEIERx (x = 1 – 12)

15 ​– 8
7
6
5
4
3
2
1
0

зарезервировано
INTx.8
INTx.7
INTx.6
INTx.5
INTx.4
INTx.3
INTx.2
INTx.1

Регистр подтверждения прерываний (PIEACK)

15 – 8
7
6
5
4
3
2
1
0

зарезервировано
PIEACKx

Регистр PIECTRL

15 – 1
0

PIEVECT
ENPIE

#include “DSP281x_Device.h”


PieCtrlRegs.PIEIFR1.bit.INTx4 = 1;
// программная








// установка флага








// ждущего прерывания








// для XINT в








// группе 1


PieCtrlRegs.PIEIER3.bit.INTx5 = 1;
// разрешить








// прерывание CAPINT1








// группы 3


PieCtrlRegs.PIEACK.all = 0x0004;
// подтвердить








// прерывание по








// группе 3


PieCtrlRegs.PIECTRL.bit.ENPIE = 1;
// включить PIE

Таблица Векторов Прерываний PIE
Рисунок

Расположение Векторов PIE (ENPIE = 1)

Название вектора
Адрес вектора PIE
Описание вектора PIE

Не используется
0x00 0D00
Вектор сброса, никогда не используется в этом месте

INT1
0x00 0D02
INT1 распределен ниже

…
…
… распределен ниже

INT12
0x00 0D18
INT12 распределен ниже

INT13
0x00 0D1A
Вектор прерывания XINT1

INT14
0x00 0D1C
Вектор операционной системы реального времени – Timer2

Datalog
0x00 0D1D
Вектор сборщика данных

…
…
…

USER11
0x00 0D3E
Пользовательское прерывание TRAP

INT1.1
0x00 0D40
Вектор прерывания PIEINT1.1

…
…
…

INT1.8
0x00 0D4E
Вектор прерывания PIEINT1.8

…
…
…

INT12.1
0x00 0DF0
Вектор прерывания PIEINT12.1

…
…
…

INT12.8
0x00 0DFE
Вектор прерывания PIEINT12.8

· Область векторов PIE занимает 256 слов памяти данных с адреса 0x00 0D00

· Вектора сброса и INT1 – INT8 переопределены

· ??? Вектора CPU переопределены на адрес 0x00 0D00 в памяти данных

Таблица Соответствия Векторов PIE в F281x

INTx.8
INTx.7
INTx.6
INTx.5
INTx.4
INTx.3
INTx.2
INTx.1

INT1
WAKEINT
TINT0
ADCINT
XINT2
XINT1

PDPINTB
PDPINTA

INT2

T1OFINT
T1UFINT
T1CINT
T1PINT
CMP3INT
CMP2INT
CMP1INT

INT3

CAPINT3
CAPINT2
CAPINT1
T2OFINT
T2UFINT
T2CINT
T2PINT

INT4

T3OFINT
T3UFINT
T3CINT
T3PINT
CMP6INT
CMP5INT
CMP4INT

INT5

CAPINT6
CAPINT5
CAPINT4
T4OFINT
T4UFINT
T4CINT
T4PINT

INT6


MXINT
MRINT


SPITXINTA
SPIRXINTA

INT7









INT8









INT9


ECAN1INT
ECAN0INT
SCITXINTB
SCIRXINTB
SCITXINTA
SCIRXINTA

INT10









INT11









INT12









Отображение Векторов Прерываний Устройства – Обобщение

Рисунок

Отклик на Прерывание и Задержка на Обработку

Отклик на прерывание – аппаратная последовательность

Действие CPU
Описание

Регистры → stack
14 слов регистров автоматически сохраняются в стеке

0 → IFR (bit)
Очищается соответствующий бит IFR

0 → IER (bit)
Очищается соответствующий бит IER

1 → INTM/DBGM
Запрещаются все прерывания и отладка

Вектор → PC
Вектор загружается в счетчик команд

Очищаются остальные статусные биты
Очищаются LOOP, EALLOW, IDLESTAT

Примечание: некоторые действия происходят одновременно, ни одно из них не прерываемо.

Сохраняемые регистры:

T
ST0

AH
AL

PH
PL

AR1
AR0

DP
ST1

DBSTAT
IER

PC (старшее значащее слово)
PC (младшее значащее слово)

Задержка на Обработку Прерывания

Рисунок

· Минимальная задержка (до реального рабочего алгоритма в процедуре обработки прерывания):

· Внутреннее прерывание: 14 тактов

· Внешнее прерывание: 16 тактов

· Максимальная задержка определяется тактами ожидания, готовностью к прерыванию, состоянием INTM и т.д.

Инициализация Системы

Введение

Данная глава описывает работу модуля осциллятора и умножения частоты (OSC/PLL) и сторожевого таймера. Также рассмотрены режимы низкого потребления, порты дискретного ввода/вывода общего назначения и защита регистров битом EALLOW.

Цели Изучения

· Работа с модулем осциллятора и умножения частоты (OSC/PLL)

· Сторожевой таймер

· Режимы низкого энергопотребления

· Порты дискретного ввода/вывода общего назначения

· Регистры, защищенные битом EALLOW
Разделы Главы

Осциллятор и Модуль Умножения Частоты (PLL)

Рисунок

Осциллятор и модуль умножения частоты производят все необходимые C28x тактирующие сигналы. Модуль умножения частоты имеет 4-разрядное управляющее слово, переключающее частоту тактирующего сигнала для центрального процессора. Режимов работы может быть два – работа с кварцевым резонатором и с внешним тактовым генератором. При подключении внешнего резонатора, осциллятор начинает тактировать микроконтроллер. Осциллятор не работает, если используется внешний тактовый генератор. В этом случае тактируется ножка X1/CLKIN. Сторожевой таймер получает непосредственно сигнал с осциллятора. OSCCLK. Ядро C28x производит сигнал SYSCLKOUT. Частота этого сигнала делится, чтобы тактировать встроенную периферию с помощью двух делителей частоты: для низкоскоростной и высокоскоростной периферии.

Рисунок

Регистр управления тактированием периферийных устройств позволяет включать или выключать тактирующий сигнал для каждого периферийного устройства. Если периферийное устройство не используется, то выключение тактирующего сигнала приведет к уменьшению энергопотребления.

Регистр Масштабирования Частоты Тактирования Высоко- и Низкоскоростных Периферийных Устройств

HISPCP @ 0x00701A / LOSPCP @ 0x00701B (файл “SysCtrl.c”)

15 – 3
2
1
0

Зарезервировано
HSPCLK2
HSPCLK1
HSPCLK0

15 – 3
2
1
0

Зарезервировано
LSPCLK2
HSPCLK1
HSPCLK0

H/LSPCLK2
H/LSPCLK1
H/LSPCLK0
Частота периферийных устройств

0
0
0
SYSCLKOUT/1

0
0
1
SYSCLKOUT/2 (по умолчанию для высокоскоростных устройств)

0
1
0
SYSCLKOUT/4 (по умолчанию для низкоскоростных устройств)

0
1
1
SYSCLKOUT/6

1
0
0
SYSCLKOUT/8

1
0
1
SYSCLKOUT/10

1
1
0
SYSCLKOUT/12

1
1
1
SYSCLKOUT/14

Сторожевой Таймер

· Сбрасывает С28х в случае отказа ЦПУ

· Сторожевой таймер работает независимо от ЦПУ

· Когда счетчик переполняется, происходит сброс или прерывание

· ЦПУ должен прописывать правильную последовательность кодов для сброса счетчика до его переполнения

· Сторожевой таймер должен быть обслужен (или выключен) в течение 4,37 мс после сброса (для 30 МГц OSCCLK для 150 МГц устройств)

· Это примерно 131 тысяча команд

Сторожевой таймер обеспечивает защиту от неисправностей ЦПУ или его программного обеспечения, вызывая автоматический сброс, если ЦПУ не обслуживает его в течение заданного интервала. В задачах управления двигателями это позволяет защищать двигатель и силовую электронику, когда управление осуществляется неправильно вследствие зависания программы. Возникающий сброс переведет выходы ШИМ в высокоимпедансное состояние, что приведет к отключению силового преобразователя при его правильном проектировании.

Сторожевой таймер запускается сразу после сброса и вскоре должен быть обслужен программой. У Вас есть приблизительно 4,37 мс (для 150 МГц устройств) после сброса, пока сторожевой таймер не вызовет новый сброс. Это примерно 131 тысяч команд, что вполне достаточно для этой операции. За это время сторожевой таймер надо сконфигурировать как требуется и обработать. Зависание Вашего программного обеспечения или неправильное конфигурирование сторожевого таймера после сброса приведет к бесконечному циклу, инициированному сбросом сторожевого таймера.

Рисунок

Выбор Периода Сторожевого Таймера

Биты WDPS
Переключатель счетчика
Период ожидания обслуживания сторожевого таймера C28x на 150 МГц

00х
1
4,37 мс

010
2
8,74 мс

011
4
17,48 мс

100
8
34,96 мс

101
16
69,92 мс

110
32
139,84 мс

111
64
279,68 мс

· WDPS устанавливается в 000 после сброса

· Сторожевой таймер начинает счет сразу после выхода из состояния сброса

Регистр Управления Сторожевым Таймером

WDCR @ 0x007029

Рисунок

Сброс Счетчика Сторожевого Таймера

WDKEY @ 0x007025

15 – 8
7
6
5
4
3
2
1
0

Зарезервировано
D7
D6
D5
D4
D3
D2
D1
D0

· Можно писать следующие значения:

· 55h – счетчик готов к сбросу при следующей записи AAh
· AAh – счетчик сбрасывается в ноль, если он был подготовлен кодом 55h
· Запись любых других значений вызывает мгновенный сброс микроконтроллера

· Сторожевой таймера не должен обслуживаться только в процедуре обработки прерываний

· Если фоновая программа зависла, но прерывания работают, то сторожевой таймер не поймает эту ситуацию

· Можно записывать 55h в сторожевой таймер в фоновой программе, а код AAh в прерывании; таким образом будут отслеживаться зависания фоновой программы и прерываний

Результат Записи в WDKEY

Шаг
Записанное значение в WDKEY
Результат

1
AAh
Нет действия

2
AAh
Нет действия

3
55h
Счетчик сторожевого таймера подготовлен для сброса

4
55h
Счетчик сторожевого таймера подготовлен для сброса

5
55h
Счетчик сторожевого таймера подготовлен для сброса

6
AAh
Сброс счетчика сторожевого таймера

7
AAh
Нет действия

8
55h
Счетчик сторожевого таймера подготовлен для сброса

9
AAh
Сброс счетчика сторожевого таймера

10
55h
Счетчик сторожевого таймера подготовлен для сброса

11
23h
Сброс 

Регистр Управления и Состояния Системы

SCSR @ 0x007022

Рисунок

Режимы Низкого Энергопотребления

Режим пониженного энергопотребления
Тактирование схем ЦПУ
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